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Accessibility Best Practices
This set of items are not technically required for compliance, but they are items that are highly recommended to ensure the end 
user has the best possible experience while interacting with your document.

Table 1. Accessibility Best Practices

ID WCAG Description of Rule Pass N/A

1A none Properties > Description “Application” or “PDF Producer” does not display “Adobe 
LiveCycle Designer”

1B none Properties > Security > “Content Copying for Accessibility” displays “Allowed”

1C none Adobe Accessibility Full Check does not display “Scripts – Needs manual check”  under the 
“Page Content” category

1D none Where no method exists to correct content so that it meets the Section 508 
requirements, an alternate version is provided

1E none Provide a 508 Checklist for each embedded or attached file

1F none
Provide a separate Accessibility Report from PDF Accessibility Checker 2021 showing no 
failures (red check marks) or warnings (yellow triangles) for either the PDF/UA and WCAG 
sections.

Alternate Text
This set of items are meant to ensure that all non-text content in your document is presented to the user with alternate text so 
they can understand the meaning without being required to see it.

Table 2. Alternate Text

1.1.1

ID WCAG Description of Rule Pass N/A

2A 1.1.1 All images and form image buttons have appropriate, concise alternative text

2B Images that do not convey content, or are decorative, have been artifacted

2C 1.1.1 Complex images have either appropriate alternate text or a separate page referencing it

2D 1.1.1 Images containing text have the text included as part of the alternate description

2E 1.1.1 Embedded multimedia is identified via accessible text

2F 1.1.1 Animated content has an alternative or is described in text

2G 1.1.1 Mathematical formulas have an alternatives or are provided as text

https://pdfua.foundation/en
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content.html
https://www.w3.org/WAI/WCAG21/Understanding/non-text-content.html
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Adaptability
This set of items are meant to ensure that all content in your document is presented in a way that it can be perceived by all users 
regardless of the way they are accessing it. Whether that is visually, audibly, tactilely or by some other means.

Table 3. Adaptability

ID WCAG Description of Rule Pass N/A

3A 1.3.1 
4.1.1 The file contain Tags

3B 1.3.1 
4.1.2 Tags match the logical reading order of the file

3C 1.3.1 
4.1.2 Non-standard Tags are role mapped to the appropriate standard Tags

3D 1.3.1 Heading levels are designated with the appropriate Tags (<H1> - <H6>)

3E 1.3.1 Heading Tags are set in the correct sequence (<H1>, <H2>, <H3>, etc)

3F 1.3.1 Table of Contents are tagged with the correct structure (<TOC>, <TOCI>, etc)

3G 1.3.1 Lists are tagged with the correct structure (<L>, <LI>, etc)

3H 1.3.1 Sub-lists have are tagged with the correct nested tag structure

3I 1.3.1 Tables are used for tabular data (not a layout table)

3J 1.3.1 Table headings are tagged with the correct structure (<TH>)

3K 1.3.1 Table headings are correctly associated to their data cells (scope set to column or row) 

3L 1.3.1 Merged cells have the correct RowSpan or ColSpan applied

3M 1.3.1 Table captions and summaries are applied

3N 1.3.1 Tables are not used as layout tables

3O 1.3.1 Form input elements have tool tips that identify their purpose and match the associated 
text

3P 1.3.1 Related form elements and elements with multiple labels are grouped appropriately 
(group names are identified as part of the tool tip, radio buttons have the same name, etc)

3Q 1.3.2 Reading and navigation order (determined by Show/Hide>Navigation Panes>Tags) is in the 
logical and intuitive order

3R 1.3.2 All meaningful content appears in the Tags pane

3S 1.3.3 Vital content from a header, footer, or watermark is provided in the document

3T 1.3.4 Repetitive or decorative content is artifacted

3U 1.3.3 Instructions do not rely upon shape, size, or visual location (“Click the square icon to 
continue” or “Instructions are in the right-hand column”)

3V 1.3.3 Instructions do not rely upon sound (“A beeping sound indicates you may continue”) 

https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/TR/UNDERSTANDING-WCAG20/ensure-compat-parses.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/name-role-value.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/name-role-value.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG22/Understanding/meaningful-sequence.html
https://www.w3.org/WAI/WCAG22/Understanding/meaningful-sequence.html
https://www.w3.org/WAI/WCAG22/Understanding/sensory-characteristics.html
https://www.w3.org/WAI/WCAG22/Understanding/orientation.html
https://www.w3.org/WAI/WCAG22/Understanding/sensory-characteristics.html
https://www.w3.org/WAI/WCAG22/Understanding/sensory-characteristics.html
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Distinguishability
This set of items are meant to ensure that a user can see and/or hear and tell the difference between all the foreground 
(important) and background (unimportant or decorative) content.

Table 4. Distinguishability

ID WCAG Description of Rule Pass N/A

4A 1.4.1 Color is not used as the only way of conveying content nor to distinguish between visual 
elements

4B 1.4.1

Color is not used as the sole method to distinguish links from surrounding text unless 
the luminance contrast between the link and the surrounding text is at least 3:1 and an 
additional differentiation (it becomes underlined) is provided when the link is hovered over 
or receives focus

4C 1.4.1 Non-text content (images) use patterns to convey the same information as color

4D 1.4.2 Multimedia/animation objects that play for more than three seconds have a mechanism to 
stop, pause, mute, or adjust the volume for audio

4E 1.4.3 Text and images of text have a contrast ratio of at least 4.5:1

4F 1.4.4 The document is readable and functionable when the text is set to re-flow (resizing of text)

4G 1.4.5
The “Scanned Page Alert” does not appear when opening the document and the Adobe 
Accessibility Full Check does not return a failed result for “Image-only PDF” or “Tagged PDF” 
under the “Document” category

Keyboard
This set of items are meant to ensure that a user can access/interact with all content in the document using a keyboard or a 
keyboard alternative interface such as a sip-and-puff software, on-screen keyboards, or other input devices other than a mouse. 

Table 5. Keyboard

ID WCAG Description of Rule Pass N/A

5A 2.1.1 All document functionality is available using the keyboard, unless the functionality cannot 
be accomplished in any known way using a keyboard (free hand drawing)

5B 2.1.1 All functionality is operable without requiring specific timings for individual keystrokes

5C
1.3.1 
2.1.1 
4.1.2

Links are tagged with the correct structure (<Link>, <Links-OBJR>, etc)

5D 2.1.2 Keyboard focus is never locked or trapped at one particular page element. The user can 
navigate to and from all navigable page elements using only a keyboard

https://www.w3.org/WAI/WCAG21/Understanding/use-of-color.html
https://www.w3.org/WAI/WCAG21/Understanding/use-of-color.html
https://www.w3.org/WAI/WCAG21/Understanding/use-of-color.html
https://www.w3.org/WAI/WCAG21/Understanding/audio-control.html
https://www.w3.org/WAI/WCAG22/Understanding/contrast-minimum.html
https://www.w3.org/WAI/WCAG21/Understanding/resize-text.html
https://www.w3.org/TR/UNDERSTANDING-WCAG20/visual-audio-contrast-text-presentation.html
https://www.w3.org/WAI/WCAG21/Understanding/keyboard.html
https://www.w3.org/WAI/WCAG21/Understanding/keyboard.html
https://www.w3.org/WAI/WCAG21/Understanding/info-and-relationships.html
https://www.w3.org/WAI/WCAG21/Understanding/keyboard.html
https://www.w3.org/WAI/WCAG21/Understanding/name-role-value.html
https://www.w3.org/WAI/WCAG21/Understanding/no-keyboard-trap.html
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Timing
This set of items are meant to ensure that a user has an appropriate amount of time to interact with time-based content or 
media within the document.

Table 6. Timing

ID WCAG Description of Rule Pass N/A

6A 2.2.1 If a page or application has a time limit, the user is given options to turn off, adjust, or 
extend that time limit

6B 2.2.2 Automatically moving, blinking, scrolling, or auto-updating content lasting longer than 5 
seconds can be paused, stopped, or hidden by the user

Flashing
This set of items are meant to ensure that your document does NOT contain flashing content as this can be a health hazard to 
many individuals with photosensitivity.

Table 7. Flashing

ID WCAG Description of Rule Pass N/A

7A 2.3.1 No page content flashes more than 3 times per second

Navigability
This set of items are meant to ensure that users can find all the content in your document plus be able to keep track of their 
current and potential location(s).

Table 8. Navigability

ID WCAG Description of Rule Pass N/A

8A 2.4.2
The document has a meaningful title indicating its purpose under Document Properties > 
Description > “Title” and Document Properties > Initial View > Window Options > Show is set 
to “Document Title”

8B 2.1.1 
2.4.3 The navigation order of links, form elements, etc. is logical and intuitive

8C 2.4.3 Keyboard focus moves to and returns from elements appropriately (the opening or 
appearance and closing of dialogs)

8D 2.4.4
The purpose of each link (or form image button) can be determined from the link text 
alone, or from the link text and its context (e.g., surrounding paragraph, list item, table cell, 
or table headers)

8E 2.4.4 Links (or form image buttons) with the same text that go to different locations are readily 
distinguishable

8F 2.4.6
Page headings, form labels, and interactive controls are informative while avoiding 
duplicative descriptors unless the structure provides adequate differentiation between 
them

8G 2.4.7 It is visually apparent which element has the current keyboard focus

https://www.w3.org/WAI/WCAG22/Understanding/page-titled.html
https://www.w3.org/WAI/WCAG21/Understanding/keyboard.html
https://www.w3.org/WAI/WCAG22/Understanding/focus-order.html
https://www.w3.org/WAI/WCAG22/Understanding/focus-order.html
https://www.w3.org/WAI/WCAG22/Understanding/link-purpose-in-context.html
https://www.w3.org/WAI/WCAG22/Understanding/link-purpose-in-context.html
https://www.w3.org/TR/UNDERSTANDING-WCAG20/navigation-mechanisms-descriptive.html
https://www.w3.org/WAI/WCAG22/Understanding/focus-visible.html
https://www.w3.org/WAI/WCAG22/Understanding/three-flashes-or-below-threshold.html
https://www.w3.org/WAI/WCAG21/Understanding/timing-adjustable.html
https://www.w3.org/WAI/WCAG21/Understanding/pause-stop-hide.html
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Language
This set of items are meant to ensure that the default language of the content can be recognized and presented in a linguistically 
correct format to the user. 

Table 9. Language

ID WCAG Description of Rule Pass N/A

9A 3.1.1 Document Properties > Advanced > Reading Options > Language displays the appropriate 
language for the document

9B 3.1.2 The language of page content that is in a different language is identified through the 
Properties of the affected tag(s) under the Tag tab > Language

Predictability
This set of items are meant to ensure that the document appears and operates in a logical and predictable way which makes it 
easier for users with various disabilities or who are using assistive technology to interact with and understand the content.

Table 10. Predictability

ID WCAG Description of Rule Pass N/A

10A 3.2.1
When a page element receives focus, it does not result in a substantial change to the page, 
the spawning of a pop-up window, an additional change of keyboard focus, or any other 
change that could confuse or disorient the user

10B 3.2.2

When a user inputs information or interacts with a control, it does not result in a substantial 
change to the page, the spawning of a pop-up window, an additional change of keyboard 
focus, or any other change that could confuse or disorient the user unless the user is 
informed of the change ahead of time

Forms
This set of items are meant to ensure that instructions or labels are provided that identify the interactions in a forms so that users 
know what input data is expected of them and how to input the data.

Table 11. Forms

ID WCAG Description of Rule Pass N/A

11A 3.3.1 
3.3.2

Required form elements or form elements that require a specific format, value, or length 
provide this information as a text description

11B 3.3.1 Form validation errors, if present, are presented in an efficient, intuitive, and accessible way

11C 3.3.2 Interactive elements at the beginning of a form have sufficient labels, cues, and 
instructions

11D 3.3.3 Suggestions are provided in an accessible manner if an input error is detected 

11E 3.3.4 If data can be deleted, it is possible to reverse and validate the deletion

https://www.w3.org/WAI/WCAG22/Understanding/error-identification.html
https://www.w3.org/WAI/WCAG22/Understanding/labels-or-instructions.html
https://www.w3.org/WAI/WCAG22/Understanding/error-identification.html
https://www.w3.org/WAI/WCAG22/Understanding/labels-or-instructions.html
https://www.w3.org/WAI/WCAG21/Understanding/error-suggestion.html
https://www.w3.org/TR/UNDERSTANDING-WCAG20/minimize-error-reversible.html
https://www.w3.org/WAI/WCAG22/Understanding/language-of-page.html
https://www.w3.org/WAI/WCAG22/Understanding/language-of-parts.html
https://www.w3.org/WAI/WCAG21/Understanding/on-focus.html
https://www.w3.org/TR/UNDERSTANDING-WCAG20/consistent-behavior-unpredictable-change.html
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